IRISconsole™
Administrator’s Guide

Document Number 007-2872-003

CONTRIBUTORS
Written by Susan Ellis, Carolyn Curtis, and Terry Schultz
Illustrated by Dan Young, Dany Galgani, and Carolyn Curtis
Production by Kirsten Pekarek
St. Peter’s Basilica image courtesy of ENEL SpA and InfoByte SpA. Disk Thrower
image courtesy of Xavier Berenguer, Animatica.
© 1997, 1998, Silicon Graphics, Inc.— All Rights Reserved
The contents of this document may not be copied or duplicated in any form, in whole
or in part, without the prior written permission of Silicon Graphics, Inc.
RESTRICTED RIGHTS LEGEND
Use, duplication, or disclosure of the technical data contained in this document by
the Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the
Rights in Technical Data and Computer Software clause at DFARS 52.227-7013
and/or in similar or successor clauses in the FAR, or in the DOD or NASA FAR
Supplement. Unpublished rights reserved under the Copyright Laws of the United
States. Contractor/manufacturer is Silicon Graphics, Inc., 2011 N. Shoreline Blvd.,
Mountain View, CA 94043-1389.
Silicon Graphics, the Silicon Graphics logo, IRIX, CHALLENGE, and Onyx are
registered trademarks and IRISconsole, O2, OCTANE, Origin, Origin200, Onyx2,
and XFS are trademarks of Silicon Graphics, Inc. Indy is a registered trademark used
under lisense in the U.S. and owned by Silicon Graphics, Inc. in all other countries
worldwide. EtherLite is a registered trademark of Central Data Corporation.
PostScript is a registered trademark of Adobe systems, Inc.

IRISconsole™ Administrator’s Guide
Document Number 007-2872-003

Contents

List of Figures

v

List of Tables vii
About This Guide ix
Audience ix
Structure of This Document x
Font Conventions Used in This Guide

x

1.

IRISconsole Features and Capabilities 1
IRISconsole Hardware Configuration 1
IRISconsole Commands 3
IRISconsole Graphical User Interface 4
IRISconsole Security 5
Overview of IRISconsole Operation 6

2.

Configuring IRISconsole 7
Installing IRISconsole Software 8
Adding an IRISconsole Administrator 9
Adding an IRISconsole User 10
Determining Whether IRISconsole Security Is On or Off 11
Setting IRISconsole Security On or Off 11
Obtaining the Multiplexer SCSI ID Number and Serial Port Connections
Determining the Multiplexer Device Name 13
SCSI Multiplexers 13
EtherLite Multiplexers 14
Setting Up IRISconsole for Remote Access 14

12

iii

Contents

3.

4.

iv

Configuring Sites 15
Starting the IRISconsole Graphical User Interface
Setting User Preferences 16
Adding a Site 18
Adding a System to a Site 20
Adding a System Partition to a Site 24

15

Administering Sites 27
Administering IRISconsole Users and Administrators 28
Displaying a List of IRISconsole Administrators or Users
Changing the Administrator’s or User’s Password 28
Deleting an Administrator or User 29
Connecting to a Remote IRISconsole Workstation 30
Viewing Site Characteristics 33
Performing Operations on Attached Systems 35
Using the Availability Monitor Report 37
Displaying the System Log 38
Displaying the Hardware Inventory of a System 38
Displaying Hardware Status Information 38
Customizing the Hardware Status Monitor Display 39
Changing Point or Line Styles for Graphs 41
Using Graph Control Panels for Specific Graphs 42
Using Alarms 43
Setting a Threshold for an Alarm 44
Clearing an Alarm 44
Viewing an Alarm Graph File 45
Using a Notify Script 45
Using Graph Files 45
Saving Graph Data to a File 46
Displaying a Graph File 47
Printing a Graph 47
Renaming or Deleting a Site 47
Modifying or Deleting a System 48

28

Contents

A.

Error Messages and Warning Messages 49
Index

57

v

List of Figures

Figure 1-1
Figure 2-1
Figure 2-2
Figure 2-3
Figure 2-4
Figure 3-1
Figure 3-2
Figure 3-3
Figure 3-4
Figure 3-5
Figure 3-6
Figure 3-7
Figure 3-8
Figure 3-9
Figure 4-1
Figure 4-2
Figure 4-3
Figure 4-4
Figure 4-5
Figure 4-6
Figure 4-7
Figure 4-8
Figure 4-9
Figure 4-10
Figure 4-11
Figure 4-12

IRISconsole Site Example 2
Adding an IRISconsole Administrator 9
Using the IRISconsole Security Window 10
Adding an IRISconsole User 10
Checking the Multiplexer SCSI ID Number 12
IRISconsole Graphical User Interface Main Window 16
Change IRISconsole Preferences Dialog Box 17
Change IRISconsole Config Dialog Box 18
IRISconsole Graphical User Interface Main Window with
Cluster Icon 19
Site Window 20
Change Site Config Dialog Box 21
IRISconsole Site With Two Systems 23
Change Partition Config Dialog Box 24
IRISconsole Site With Partitioned System Icon 25
Changing an IRISconsole Password 29
Example IRISconsole Main Window 33
Example IRISconsole Site Window 34
Selecting a Partitioned System 35
Example Availability Monitor Report 37
Example IRISconsole Hardware Status Monitor 39
View Menu 40
Global Controls Dialog Box 40
Graph Style Dialog Box 41
Graph Control Panel for Blower Speed 42
Graph Control Panel for Temperature 44
Saving a Graph File 46

vii

List of Tables

Table 2-1

Example Table for Server Multiplexer Port Numbers

13

ix

About This Guide

This guide documents the IRISconsole software graphical user interface for a Silicon
Graphics OCTANE, O2, or Indy workstation that allows it to control Origin,
CHALLENGE, Onyx2, and Onyx systems. The IRISconsole software is included in the
base IRISconsole option, which includes any one of the following IRISconsole
multiplexers: ST-1600, ST-1616, ST-1620, ST-1032, EL-8, or EL-16. Serial cables, which are
specific to the type of system controlled, are provided by additional IRISconsole options
and complete the IRISconsole package.
The OCTANE, O2, or Indy workstation communicates with the servers through the
multiplexer, to which each Origin, CHALLENGE, or Onyx system is connected via a pair
of serial cables. Each multiplexer has ports for eight or more Origin, CHALLENGE, and
Onyx systems; additional sets of serial cables are available from Silicon Graphics.
Optionally, an additional multiplexer can be connected to the workstation to monitor
additional servers.
This guide was prepared in conjunction with release 1.3 of IRISconsole.

Audience
This guide is written for system administrators and service personnel who are
responsible for the configurations of two or more Origin, CHALLENGE, or Onyx
systems that the IRISconsole controls and monitors. These persons can use the
IRISconsole software to monitor the attached systems.

xi

About This Guide

Structure of This Document
This guide contains the following chapters and appendixes:
•

Chapter 1, “IRISconsole Features and Capabilities,” introduces IRISconsole features
and describes how IRISconsole works with Origin, CHALLENGE, and Onyx
systems. This chapter explains how to use the IRISconsole security feature.

•

Chapter 2, “Configuring IRISconsole,” describes how to set up IRISconsole software
in preparation for configuring and administering groups of systems.

•

Chapter 3, “Configuring Sites,” explains how to use the IRISconsole graphical user
interface to set up groups of systems for administration purposes.

•

Chapter 4, “Administering Sites,” explains how to use the IRISconsole graphical
user interface for administration tasks such as determining hardware status
(voltage, operating temperature, and blower speeds), and controlling, shutting
down, or restarting systems in a site.

•

Appendix A, “Error Messages and Warning Messages,” lists and explains
IRISconsole error and warning messages.

An index completes this guide.

Font Conventions Used in This Guide
These font conventions are used in this guide:
Italics

Executable names, filenames, IRIX commands, manual or book titles,
new terms, program variables, tools, utilities, variable command line
arguments, variable coordinates, and variables to be supplied by the
user in examples, code, and syntax statements

Fixed-width type

Error messages, prompts, and onscreen text
Bold fixed-width type

User input, including keyboard keys (printing and nonprinting); literals
supplied by the user in examples, code, and syntax statements

xii

Chapter 1

1. IRISconsole Features and Capabilities

This chapter introduces the operational features and capabilities of the IRISconsole
software. The major sections in this chapter are as follows:
•

“IRISconsole Hardware Configuration” on page 1

•

“IRISconsole Graphical User Interface” on page 4

•

“IRISconsole Security” on page 5

•

“Overview of IRISconsole Operation” on page 6

IRISconsole Hardware Configuration
The IRISconsole software allows an OCTANE, O2, or Indy workstation to control
Origin200, Origin2000, CHALLENGE, Onyx2, and Onyx systems through one to six
SCSI-based multiplexers and up to ten Ethernet-based multiplexers of the following
Silicon Graphics multiplexers: ST-1600, ST-1616, ST-1620, ST-1032, EL-8, or EL-16. Serial
cables that are ordered as separate the IRISconsole option products connect the Remote
System Control port and the System Console port on each server to the multiplexer.
IRISconsole includes a security feature that lets you specify administrators and users
who will have access to the functions of IRISconsole. Also, certain features of IRISconsole
can be accessed remotely using ictelnet, a version of telnet that works with IRISconsole.
IRISconsole is a local system; the IRISconsole software applies only to systems that are
physically attached to the multiplexer connected to the OCTANE, O2, or Indy
workstation on which the IRISconsole software is running. The IRISconsole software
cannot communicate with another system running IRISconsole to share access to
attached systems.
Cabling the multiplexer and Origin, CHALLENGE, Onyx2, and Onyx systems is
explained in the IRISconsole Multiplexer Installation Guide (007-2839-nnn), online man
pages, and EtherLite multiplexer hardware installation guides available at
http://www.cd.com/elprod.html. Figure 1-1 shows an example IRISconsole site installation.
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Figure 1-1

2

IRISconsole Site Example

IRISconsole Commands

Hardware requirements for the IRISconsole software are as follows:
•

The 24-bit O2 or Indy workstation or OCTANE workstation must have a minimum
of 32 MB of memory and must be running IRIX 6.2, 6.3, 6.4, or 6.5. The 20-inch
display is strongly recommended for IRISconsole operation, as are XFS file systems,
for their decreased recovery time and typically better performance.

•

If one of the attached servers is a CHALLENGE S, or if an attached CHALLENGE
or Onyx system does not have a Remote System Control port, not all features of the
IRISconsole software are available. An upgrade consisting of an RS-232 plate
assembly is available to equip CHALLENGE L servers that lack this port; contact
your service representative.

•

Only cables ordered as IRISconsole options are supported for connecting the Origin,
CHALLENGE, Onyx2, and Onyx systems to the multiplexer. The IRISconsole
Multiplexer Installation Guide describes these cables.

IRISconsole Commands
The IRISconsole software includes two commands, icpass and ictelnet, that are shell
commands for administering and using IRISconsole. The third IRISconsole command is
ic, which brings up a graphical user interface. It is described in the next section,
“IRISconsole Graphical User Interface.”
icpass is used for setting up and maintaining administrator and user logins, each with a
password. These logins and passwords are specific to IRISconsole and are independent
of system logins and passwords. Using icpass, you can
•

determine whether IRISconsole security is off or on

•

add an IRISconsole administrator

•

add an IRISconsole user

•

change the administrator’s or user’s password

•

delete an administrator or user

•

set IRISconsole security off or on

•

view a list of IRISconsole users

3
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Using icpass is described in Chapter 2, “Configuring IRISconsole,” and Chapter 4,
“Administering Sites.”
You can use the command ictelnet, which is a version of telnet adapted for IRISconsole, to
access the IRISconsole text-based menu from another system.
Preparing the IRISconsole OCTANE, O2, or Indy system for using ictelnet is described in
the section “Setting Up IRISconsole for Remote Access” in Chapter 2. Using ictelnet is
described in the section “Connecting to a Remote IRISconsole Workstation” in Chapter 4.
The IRISconsole 1.3 release uses a new database to store site and system information. The
icdbcnvrt command is run by installation software to convert site and system information
from the IRISconsole 1.2 release to the IRISconsole 1.3 release.

IRISconsole Graphical User Interface
The IRISconsole graphical user interface (GUI) enables you to set up and administer sites.
A site is a group of workstations, servers, or other systems that are administered through
IRISconsole.
The command that invokes the IRISconsole GUI is called ic. You can use the IRISconsole
GUI to
•

set up a site or add or delete the systems in a site

•

display, view, or take control of the console of a system

•

generate a nonmaskable interrupt (NMI), perform a hardware reset, or power cycle
a system
Note: System controllers on Origin and Onyx2 systems have passwords, which are

different from IRIX login passwords. In this release of IRISconsole, generating an
NMI, performing a hardware reset, and power cycling a system require that system
controller passwords have their default values.
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•

view activity logs and other system reports

•

connect to the system controller on an Origin or Onyx2 system and issue system
controller commands

IRISconsole Security

•

view real-time graphs of hardware operating statistics of a system in a site, such as
voltage, operating temperature, and blower speeds; save the graphs as files and
display them (this feature is not available on Origin and Onyx2systems)

•

set a threshold for operating statistics so that an alarm is activated and various
activities are triggered when the threshold is exceeded (this feature is not available
on Origin and Onyx2 systems)

Chapter 3, “Configuring Sites,” and Chapter 4, “Administering Sites,” in this guide
explain how use the IRISconsole GUI to set up sites and administer sites, respectively.

IRISconsole Security
IRISconsole includes security features that use local password protection to assist
administrators in securing IRISconsole and its managed systems from unauthorized
access. When IRISconsole security is turned on (the default), access to certain operations
is controlled. Some of these operations are represented by buttons in the site window of
the IRISconsole GUI. The operations that are controlled when security is turned on are as
follows:
•

adding or deleting sites and systems in the sites (Edit pulldown menu)

•

getting the console (Get Console), viewing the console window of a system
controlled by another user (Spy Console), and taking control of a system console that
another user is currently using (Steal Console)

•

generating a non-maskable interrupt (Generate NMI)

•

performing hardware reset (HW Reset) and power cycle (Power Cycle)

•

viewing console activity logs (Show Console Logs)

Note: Generate NMI, HW Reset, and Power Cycle on Origin and Onyx2 systems require

that the system controllers on those systems have default passwords.
Checking the current security setting and changing it are described in the sections
“Determining Whether IRISconsole Security Is On or Off” and “Setting IRISconsole
Security On or Off” in Chapter 2.
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Overview of IRISconsole Operation
The installation and operation of IRISconsole consists of these major steps:
1.

Install the multiplexer hardware and cable it to the OCTANE, O2 , or Indy
workstation and the systems you plan to control. See the IRISconsole Multiplexer
Installation Guide for instructions. Additional information is also available in online
man pages, and EtherLite multiplexer hardware installation guides available at
http://www.cd.com/elprod.html.

2. Install the IRISconsole software and configure it: specify administrators and users,
choose the security setting, identify multiplexer port numbers, and prepare for
remote access. See Chapter 2, “Configuring IRISconsole,” for instructions.
3. Specify sites, groups of workstations, servers, or other systems that are to be
administered through IRISconsole. See Chapter 3, “Configuring Sites,” for
instructions.
4. Use the features of the IRISconsole graphical user interface to administer the sites.
See Chapter 4, “Administering Sites,” for details.
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Chapter 2

2. Configuring IRISconsole

This chapter describes various tasks that you must perform to install and perform the
initial configuration of IRISconsole software. The major sections in this chapter are as
follows:
•

“Installing IRISconsole Software” on page 8

•

“Adding an IRISconsole Administrator” on page 9

•

“Adding an IRISconsole User” on page 10

•

“Determining Whether IRISconsole Security Is On or Off” on page 11

•

“Setting IRISconsole Security On or Off” on page 11

•

“Obtaining the Multiplexer SCSI ID Number and Serial Port Connections” on
page 12

•

“Determining the Multiplexer Device Name” on page 13

•

“Setting Up IRISconsole for Remote Access” on page 14
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Installing IRISconsole Software
To install IRISconsole software, install these subsystems:
eoe.sw.uucp
UUCP software required by IRISconsole software
sgitcl_eoe.sw.base
Tcl toolkit software required by IRISconsole software
sgitcl_eoe.sw.tm
Tcl toolkit software required by IRISconsole software
Note: You must choose the sts.xx.xx subsystems or the el_serial.xx.xx subsystems, or both,

depending upon which multiplexer(s) your site is using.
sts.sw.base
Multiplexer software
sts.man.man
Reference pages for multiplexer software
sts.man.relnotes
Release notes for multiplexer software
el_serial.sw.base
Multiplexer software
el_serial.man.man
Reference pages for multiplexer software
el_serial.man.relnotes
Release notes for multiplexer software
IRISconsole.sw.base
IRISconsole base software
IRISconsole.sw.remoteaccess
IRISconsole software for remote access
IRISconsole.sw.tcllink
IRISconsole Tcl software
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IRISconsole.man.man
Reference pages for IRISconsole software
IRISconsole.man.relnotes
IRISconsole release notes
IRISconsole.books.IRISconsole_AG
This guide
IRISconsole.books.MUX_IG
The IRISconsole Multiplexer Installation Guide

Adding an IRISconsole Administrator
To add an IRISconsole administrator, type as root
icpass -add icadmin

The window shown in Figure 2-1 appears.

Figure 2-1

Adding an IRISconsole Administrator

Enter the new user’s login and password. Note that they are independent of that user’s
system login and password. Click the Apply button.
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Adding an IRISconsole User
To add an IRISconsole user, you must be an IRISconsole administrator. Type
icpass -add icuser

The window shown in Figure 2-2 appears.

Figure 2-2

Using the IRISconsole Security Window

After you enter your IRISconsole login and password and click the Apply button, the
window shown in Figure 2-3 appears.

Figure 2-3

Adding an IRISconsole User

Enter the new user’s login and password. Note that they are independent of that user’s
system login and password. Click the Apply button.
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Determining Whether IRISconsole Security Is On or Off
As described in the section “IRISconsole Security” in Chapter 1, IRISconsole can be used
to limit access to the capabilities of IRISconsole. To determine whether IRISconsole
security is on, type
icpass -security get

The software returns off or on.

Setting IRISconsole Security On or Off
To set IRISconsole security on or off, you must be an IRISconsole administrator. To set
IRISconsole security on, type
icpass -security set on

To set IRISconsole security off, type
icpass -security set off

In either case, the security window shown in Figure 2-2 appears. After you enter correct
information, a confirmation window appears with the message
Access Control status changed to ‘ON’

or
Access Control status changed to ‘OFF’
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Obtaining the Multiplexer SCSI ID Number and Serial Port Connections
In preparation for installing systems for IRISconsole, you need to obtain a SCSI ID and
port connections numbers by looking that the multiplexer and its cable connections.
Follow these steps:
1.

Get the number of the SCSI ID used by the multiplexer. This number was set when
the IRISconsole system was installed and is displayed on the back of the
multiplexer, as shown in Figure 2-4.

Note: If you are installing an EtherLite multiplexer, you do not need to determine the

SCSI ID.

1
2
3
9

4
10

5
11

6
12

7
13

8
14
15

6

7

45

01

16

23

SCSI ID
select switch

Figure 2-4
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Checking the Multiplexer SCSI ID Number

Determining the Multiplexer Device Name

2. Check the cabling for each system connected to the multiplexer to determine the
multiplexer port to which each system’s Remote System Control and System
Console ports are connected.
If you want, create a table such as the example in Table 2-1 as an aid in determining
which serial ports are used for which servers.
Table 2-1

Example Table for Server Multiplexer Port Numbers

Server Hostname

Multiplexer Port Number for
Remote System Control

Multiplexer Port Number for
System Control

jupiter

01

02

zeus

03

04

Determining the Multiplexer Device Name
Beginning with the IRISconsole 1.3 release, the way special tty devices such as the SCSI
multiplexers (ST-1600, ST-1616, and so on) or EtherLite multiplexers (EL-8 and EL-16) are
created and used has changed. This section describes how to determine the device name
for your multiplexer(s).

SCSI Multiplexers
To determine the name of a SCSI multiplexer, use:
/dev/ttyd{bus}{scsi_id}{port}
where:
•

bus is 0, 1, or 2 corresponding to the first, second, or third SCSI multiplexer found.

•

scsi_id is the ID of the ST-xxxx number on the SCSI multiplexer.

•

port is 0 - 9 or a - v, which corresponds to the port on the SCSI multiplexer numbered
1 through 32 (for example, port 1 = 0, port 11 = a).

Note: On the ST-1616 multiplexer, the ports are numbered 1 through 16, which

correspond to ports 0 - 9 and a - f on the tty device. On the ST-1032 multiplexer, the ports
are numbered 1 through 32, which correspond to ports 0 - 9 and a - v on the tty device.
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EtherLite Multiplexers
To calculate the name of an EtherLite multiplexer, use:
/dev/ttydn{elps}{port}
where:
•

elps is the EtherLite number from the /etc/els.conf file associated with an IP address.

•

port is also 0 - 9 or a - f, which corresponds to port numbers 1 - 16 (for example, port
1 = 0, port 16 = f).

Setting Up IRISconsole for Remote Access
You can use the command ictelnet, which is a version of telnet adapted for IRISconsole, to
access the IRISconsole text-based menu from another system. Follow these steps to
prepare the IRISconsole system for remote access using ictelnet:
1.

To configure a port on the IRISconsole system so that ictelnet communicates directly
to the IRISconsole application, edit the file /etc/services on that system to include the
following line, which specifies the port on which the service is available:
ictelnet 5000/tcp # IRISconsole Remote Access service

For the port number, use any number between 5000 and 5063; the number 5000 is
recommended for the status port.
2. Edit the file /etc/inetd.conf on the IRISconsole system to include this line:
ictelnet stream tcp

14

nowait

root /usr/IRISconsole/bin/ictelnetd ictelnetd

Chapter 3

3. Configuring Sites

This chapter explains how to use the IRISconsole graphical user interface (GUI) to set up
a site, configure a site, edit a site configuration, add a system to a site, or delete a site
configuration. The major sections in this chapter are as follows:
•

“Starting the IRISconsole Graphical User Interface” on page 15

•

“Setting User Preferences” on page 16

•

“Adding a Site” on page 18

•

“Adding a System to a Site” on page 20

•

“Adding a System Partition to a Site” on page 24

Starting the IRISconsole Graphical User Interface
The IRISconsole GUI main window enables you to set up a site, configure a site, edit a
site configuration, add a system to a site, or delete a site configuration.
To start the IRISconsole GUI, follow these steps:
1.

Make sure the OCTANE, O2, or Indy workstation, multiplexer, and the Origin,
CHALLENGE, Onyx2, and Onyx systems to be administered are cabled as
described in the IRISconsole Multiplexer Installation Guide, online man pages, and
EtherLite multiplexer hardware installation guides available at
http://www.cd.com/elprod.html.

2. Make sure all systems are powered on.
3. The IRISconsole security feature is on by default; to check it or toggle it on or off,
follow instructions in the sections “Determining Whether IRISconsole Security Is
On or Off” “Setting IRISconsole Security On or Off” in Chapter 2.
4. To start the IRISconsole graphical user interface in an IRIX window, enter
ic
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The IRISconsole GUI main window appears, as shown in Figure 3-1.

Figure 3-1

IRISconsole Graphical User Interface Main Window

To exit the IRISconsole GUI, choose Quit from the File menu or press Ctrl+Q.

Setting User Preferences
The Edit menu in the IRISconsole GUI main window lets you turn off dialog boxes that
ask you to confirm closing IRISconsole, closing a site, deleting a site, discarding site
changes, overwriting a configuration, saving a site configuration, and saving a system
configuration. You can also specify the directory that will receive any console and alarm
messages.

16

Setting User Preferences

To set IRISconsole user preferences, follow these steps:
1.

From the Edit menu, choose User Preferences.... The Change IRISconsole
Preferences dialog box appears, as shown in Figure 3-2.

Figure 3-2

Change IRISconsole Preferences Dialog Box

2. Click in the box to the right of each action to turn on or turn off the dialog box that
asks you to confirm an action.
3. In the Console Logs Directory field, type the location of the directory you want to
receive console messages.
4. In the Alarm Logs Directory field, type the location of the directory you want to
receive alarm messages.
5. Click the Apply button. You can use the Reset button to restore check marks to all of
the actions.
6. Click the Close button to exit the Change IRISconsole Config dialog box.
17
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Adding a Site
To set up an IRISconsole site, follow these steps:
1.

From the Edit menu, choose Add New Site.... The Change IRISconsole Config
dialog box appears, as shown in Figure 3-3.

Figure 3-3

Change IRISconsole Config Dialog Box

2. In the Site field, type a name for the site.
3. Click the Apply button.
The name of the configuration file appears in the Config field; its name is based on
the system name; based on the following, /var/IRISconsole/.IC/site name/system
names, where system names are configuration files with all the pertinent information.
4. To save the new site configuration, choose Save IRISconsole Config from the File
menu in the main IRISconsole window.

18

Adding a Site

5. To add another site, edit the entry in the Site field or click the Reset button to clear
the field. After you click the Apply button, the name of the new configuration file
appears automatically in the Config field. Figure 3-4 shows a site named
CM_cluster. Save the new site configuration as in step 4.

Figure 3-4

IRISconsole Graphical User Interface Main Window with Cluster Icon

6. When you are finished adding systems to the site, close the site window by clicking
the Close button.
7. To save the configuration, choose Save IRISconsole Config from the File menu. The
site name directories and system name configuration files will be saved to the
IRISconsole directory /var/IRISconsole/.IC. Click the Close button to exit the Change
IRISconsole Config dialog box.

19
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Adding a System to a Site
To add a system to a site, follow these steps:
1.

In the IRISconsole main window, double-click the site to which you want to add a
system or select the system and choose Open Site... from the Operations menu. The
site window opens, as shown in Figure 3-5.

Figure 3-5
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Site Window

Adding a System to a Site

2. In the site window, choose Add New System... from the Edit menu. If IRISconsole
security is on, you are prompted for your password.
After you enter your password, the Change Site Config dialog box appears, as
shown in Figure 3-6.

Figure 3-6

Change Site Config Dialog Box

3. In the System Name field, type the hostname of the system you want to add to this
site.
4. Click the Multiplexer Ctrl:Id: option button to choose the type of multiplexer for
this system. A number of multiplexers may be listed, such as ST-1600, ST-1616,
ST-1620, ST-1032, EL-8, or EL-16.
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5. Using the entries you made in a table similar to Table 2-1, enter the multiplexer port
numbers to which cables to the Console port and Remote System Control port are
connected in the Console Port# and Remote System Control Port# fields,
respectively.
6. In the Login field, enter the login under which all operations requiring access to the
system via the network can be performed. This login is the one used in the
command
rsh login@system /usr/etc/sysctlrd -p

Note: The IRISconsole security login is separate from this system login; IRISconsole

security is explained in “IRISconsole Security” in Chapter 1.
7. In the Baud Rate field, enter the baud rate at which this system sends data to
IRISconsole; the default is 9600. If you enter a different baud rate, be sure that the
system has been configured for that rate.
8. Click the box at Log Console Activity to File if you want console activity logged to a
file in the /var/IRISconsole/logs/console_logs directory that has the format
systemname.<timestamp>.log. The format of this filename cannot be changed.
Note: To view a log of a system’s console activity (Spy Console button or command)

or to view console activity logs (View Console Logs button or command), this box
must be checked when the system is added to a site.
9. Click the box at Default System Controller Password if the system controller
password has the default value. This box applies only to Origin and Onyx2 systems.
If the system controller doesn’t have the default password, the operations Generate
NMI, HW Reset, and Power Cycle are not available; Connect SYSCTLR must be used
instead (see the section “Performing Operations on Attached Systems” in
Chapter 4).
10. Click on the System Type option button and choose the type of the system.
11. When you are satisfied with the settings for this system, click the Apply button to
add this system to the site.
12. To save the configuration, choose Save Site Config from the site window File menu.

22

Adding a System to a Site

13. To add another system to the site, edit the entries in the fields of the Change Site
Config dialog box, or click the Reset button to clear all entries and begin entering
again. Follow instructions in steps 3 through 12 for the new system. Figure 3-7
shows an IRISconsole site with two systems.

Figure 3-7

IRISconsole Site With Two Systems

14. When you are finished adding systems to the site, close the Change Site Config
dialog box by clicking the Close button.
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Adding a System Partition to a Site
IRISconsole supports partitioned systems. To add a system partition to a site, follow
these steps:
1.

In the IRISconsole main window, double-click the site to which you want to add a
system or select the system and choose Open Site... from the Operations menu. The
site window opens, as shown in Figure 3-5.

2. In the site window, choose Add New Partitioned System... from the Partitioned
Systems menu. If IRISconsole security is on, you are prompted for your password.
3. After you enter your password, the Change Partition Config dialog box appears, as
shown in Figure 3-8.

Figure 3-8
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Change Partition Config Dialog Box

Adding a System Partition to a Site

4. Follow steps through 4 through 14 in “Adding a System to a Site” on page 20, to
complete the procedure.
A system partition is represented by a unique icon as shown in Figure 3-9.

Figure 3-9

IRISconsole Site With Partitioned System Icon
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4. Administering Sites

This chapter explains how to use the IRISconsole graphical user interface (GUI) and
IRISconsole commands to administer IRISconsole and the servers and other devices in
sites that it controls. The major sections in this chapter are as follows:
•

“Administering IRISconsole Users and Administrators” on page 28

•

“Connecting to a Remote IRISconsole Workstation” on page 30

•

“Viewing Site Characteristics” on page 33

•

“Performing Operations on Attached Systems” on page 35

•

“Using the Availability Monitor Report” on page 37

•

“Displaying the System Log” on page 38

•

“Displaying the Hardware Inventory of a System” on page 38

•

“Displaying Hardware Status Information” on page 38

•

“Using Alarms” on page 43

•

“Using Graph Files” on page 45

•

“Renaming or Deleting a Site” on page 47

•

“Modifying or Deleting a System” on page 48
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Administering IRISconsole Users and Administrators
The icpass command is used to list administrators and users, change their passwords, and
delete them. Performing these tasks is described in the following subsections. (Adding
administrators and users is described in the sections “Adding an IRISconsole
Administrator” and “Adding an IRISconsole User” in Chapter 2.)

Displaying a List of IRISconsole Administrators or Users
To display a list of IRISconsole administrators, type
icpass -list icadmin

To display a list of IRISconsole users, type
icpass -list icuser

In each case, IRISconsole prints the path of the password file.

Changing the Administrator’s or User’s Password
To change an IRISconsole administrator’s or user’s password, type
icpass -change icuser

or
icpass -change icadmin

The window shown in Figure 4-1 appears.

28

Administering IRISconsole Users and Administrators

Figure 4-1

Changing an IRISconsole Password

Enter the login for the user whose password you want to change. Enter the user’s old
password and new password, and click the Apply button.

Deleting an Administrator or User
To delete an IRISconsole administrator or user, you must be an IRISconsole
administrator. Type
icpass -delete icadmin icadminlogin

or
icpass -delete icuser icuserlogin

The security window shown in Figure 2-2 appears. After you enter correct information,
a confirmation window appears with the message
Entry deleted from password database

29

Chapter 4: Administering Sites

Connecting to a Remote IRISconsole Workstation
You can use the command ictelnet to access the IRISconsole text-based menu from
another system. Follow these steps:
1.

If you haven’t already done so, configure the IRISconsole system for remote access.
Follow the instructions in the section “Setting Up IRISconsole for Remote Access” in
Chapter 2.

2. To use ictelnet from any system, type
ictelnet consolehostname port

The port number should be the port number value for ictelnet services in the
/etc/services file determined in step 1 of “Setting Up IRISconsole for Remote Access”
in Chapter 2 of this manual.
Note: The recommended port number is 5000.

The software prompts for your IRISconsole login and password.
3. Enter your IRISconsole login and password as they were entered with icpass -add
icuser or icpass -add icadmin; see “Adding an IRISconsole Administrator” in
Chapter 2 for details.
After a few lines of response, the available IRISconsole sites are listed, for example:
Main Menu:
Available Sites
--------------1. eng1a
2. eng1b
3. eng1c
Enter choice (1 - 3) or ’q’ to Quit:

If a network connection from the remote host you are using to the IRISconsole
system is not available, you have two choices:
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•

log in to the IRISconsole system via modem and use ictelnet from there

•

if you have a (modem) SLIP or PPP connection, you can run the IRISconsole
GUI remotely

Connecting to a Remote IRISconsole Workstation

4. Enter the number for the site to which you want to connect.
Text like the following appears:
Site ’eng1a’:
Available Systems
----------------1. eng1a
2. eng1b
3. eng1c
Enter choice (1 - 3) or ’..’ for Main Menu:

If an entry beneath the “Available Systems” heading is a partitioned array, “(PA)” is
appended to the system name. If this system is chosen another submenu is
displayed, and text like the following appears:
System: elements
Available Partitions
--------------------1. mercury
2. argonne
Enter choice (1 - 2) or ‘ ..’ for Main Menu:

5. Enter the number for the system to which you want to connect.
The Available Operations menu appears, for example:
System ’eng1a’:
Available Operations
-------------------1. Connect to Console
2. Hardware Reset
3. Generate NMI
4. Power Cycle
5. Steal Occupied Console Line
6. Connect to System Controller
7. Start Service Tool
Enter choice (1 - 5) or ’..’ for Systems Menu:

Note: HW Reset, Generate NMI, and Power Cycle on an Origin or Onyx2 system

requires that the system controller have the default password.
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6. Enter the number for the operation you want to perform.
The following message appears:
This operation is protected.
Please enter your IRISconsole login and password.
IRISconsole Login:

7. Enter your IRISconsole login and password at the prompt.
Status and other information like the following appears:
------Connected Port=/dev/ttyd043 -----9600 BAUD 8 NONE 1 SWFC=ON HWFC=OFF
CAR=ON DTR=ON RTS=ON CTS=ON DSR=ON
Type ~? for Help, ~X to Exit.
Connection Ready.

8. Use the tilde commands ((+-)Baud Csize Dtr Framing Hwfc Info breaK Modem
Oflush Parity Rts Swfc eXit) to change settings; you need not press <Enter>.
For example, ~S (note that this letter is uppercase) toggles software flow control and
displays a message similar to:
9600 BAUD 8 NONE 1 SWFC=OFF HWFC=OFF
^^^^^^^^

9. To exit ictelnet, type ~X.
This command returns you to the Available Operations menu for the system that
was described in step 5 of this procedure.
10. From the Available Operations menu, type.. to exit to the Systems Menu, type.. to
exit to the Main Menu, then type q to exit to the IRIX prompt.
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Viewing Site Characteristics
To see characteristics for a site, double-click its name in the scrolling list of sites in the
IRISconsole main window. Figure 4-2 shows an example main window.

Figure 4-2

Example IRISconsole Main Window

Alternatively, you can select a site and then choose Open Site... from the IRISconsole
main window Operations menu. Figure 4-3 shows an example site window.
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Figure 4-3

Example IRISconsole Site Window

To get a console for a system that is part of a partitioned system, you must choose a
partition from the list that appears when you choose Select Partition... from the
Partitioned Systems menu as shown in Figure 4-4.

34

Performing Operations on Attached Systems

Figure 4-4

Selecting a Partitioned System

Performing Operations on Attached Systems
You can use the buttons in the site window (see Figure 4-3) for system administration
tasks. All but the HW Status button display a window in which you type your
IRISconsole login and password as it was entered in the IRISconsole security facility; see
“IRISconsole Security” in Chapter 1. The buttons are as follows:
Get Console

To access and display a system’s console window, select the system and
click the Get Console button. The console window appears on the
workstation screen.

Generate NMI
To generate a non-maskable interrupt (forcing a panic in the operating
system), click the Generate NMI button.
Note: Generate NMI on an Origin or Onyx2 system requires that

system’s system controller have the default password.
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HW Reset

To reset a system in a site (hardware reset), select the system and click
the HW Reset button. A confirmation message appears.
Note: HW Reset on an Origin or Onyx2 system requires that system’s

system controller have the default password.
Power Cycle

To power-cycle a system, or to power on a system that has been turned
off, select the system and click the Power Cycle button.
In the case of a power cycle, the system controller removes the power
enable control signals, waits five seconds, and restores power. Boot
arbitration is started after power is reapplied.
Note: Power Cycle on an Origin or Onyx2 system requires that system’s
system controller have the default password.

Steal Console

To take control of a system console that another user is currently using,
select the system and click the Steal Console button. The console window
appears on the workstation screen. The original user sees the message
IRISconsole DINC closing...; that owner’s session is killed.

Spy Console

To display a window showing console activity of a system in progress,
select the system and click the Spy Console button. In order to view this
activity, the Log Console Activity to File option must have been checked
when the system is added to a site, as explained in step 8 in “Adding a
System to a Site” in Chapter 3.

Show Console Logs
To view console logs (stored in /var/IRISconsole/logs/console_logs/), select
the system and click the Show Console Logs button. In order for these logs
to be written, an IRISconsole user must be connected via the Get Console
command and the system must have been configured with the Log
Console Activity to File option checked, as explained in step 8 in
“Adding a System to a Site” in Chapter 3.
HW Status

To display graphs of system activity, click the HW Status button. The
Hardware Status Monitor appears; this feature is explained in detail in
the section “Displaying Hardware Status Information” later in this
chapter. This feature requires a network connection between the
OCTANE, O2, or Indy host and the target system.

Connect SYSCTRL
To access and display a system’s system controller port window, select
the system and click the Connect SYSCTRL button. The system controller
window appears on the workstation screen. This is used primarily on
Origin and Onyx2 systems.
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Start Serv Tool
To start the Service Tool, a tool intended for use by Silicon Graphics field
personnel, select a system and click the Start Serv Tool button. A shell
window appears.
For each of these tasks, you can also choose the corresponding command from the
Operations menu.

Using the Availability Monitor Report
The IRISconsole Availmon report gives a snapshot of availability information on a
system. It is a condensation of the information in /var/adm/avail/availlog, displayed in a
format similar to that of /var/adm/avail/amreport.
To display the Availmon report, follow these steps:
1.

Make sure that availmon is installed and active on the Origin, CHALLENGE, Onyx2,
and Onyx systems you wish to access (use /etc/chkconfig).

2. In the site window, select the system for which you want a report.
3. Choose Availmon Report... from the Monitor menu. A window like the one in
Figure 4-5 appears.

Figure 4-5

Example Availability Monitor Report
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Displaying the System Log
To display the SYSLOG for a system, select the system in the site window. Choose Show
Syslog... from the Monitor menu.
To update the SYSLOG display, close the syslog window and choose Show Syslog...
again.

Displaying the Hardware Inventory of a System
To display a hardware inventory of an attached system, select the system in the site
window and click Hardware Inventory... from the Monitor menu. The output of hinv for
that system appears in a window.

Displaying Hardware Status Information
Note: Hardware status information is not available for Origin or Onyx2 systems. This

section and its subsections do not apply to Origin or Onyx2 systems.
To display hardware operating information on a CHALLENGE or Onyx system in a site,
follow these steps:
1.

In the IRISconsole main window, double-click on the site containing the system
whose hardware operating information you want to check. The site window
appears.

2. In the Systems scrolling list of the site window, select the system for which you want
information.
3. Click the HW Status button. The IRISconsole Hardware Status Monitor appears, as
shown in Figure 4-6.
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Figure 4-6

Example IRISconsole Hardware Status Monitor

The subsections below explain how to customize the Hardware Status Monitor display,
change the point and line styles for graphs, and use graph control panels for specific
graphs.

Customizing the Hardware Status Monitor Display
To change the height of a graph in the IRISconsole Hardware Status Monitor, put the
mouse cursor on one of the two sashes (small square at the extreme right between the
graphs) and drag it down or up; the relative heights of the graphs above and below it
change.
To zoom an area of the display, select the graph you want to zoom; holding down the
Ctrl key and pressing the middle mouse button, move the mouse. Press r to reset the
display.
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You can further customize the display using options from the Hardware Status Monitor
View menu. Figure 4-7 shows the View menu.
View
Display a log showing alarm thresholds that were exceeded
Turn specific graph displays off and on

Display legends that label the line types in the graph

Figure 4-7

Alarms Log
Voltage Graph
Ctrl+V
Temperature Graph Ctrl+T
Blower Graph
Ctrl+B
Legends

View Menu

Finally, you can use the Global Controls dialog box to customize the graph data. Choose
Global Controls...from the Options menu; Figure 4-8 shows this dialog box.

For all graphs:
Set to
fastest rate
Optimize
scrollback

Set sampling rate for data
Set percentage of graph to scroll
back when limit is reached
Set number of points
displayed onscreen
(amount of graph that is
offscreen to the left)
Run notify script
when threshold is exceeded
Sound beep or tone
when threshold is exceeded
Enter message in log file
when threshold is exceeded

Figure 4-8
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Displaying Hardware Status Information

Changing Point or Line Styles for Graphs
To change the point or line style in a graph display, follow these steps:
Note: Style changes apply onscreen and for printing only; point and font style changes

are not saved when the graph is saved to a file.
1.

From the Selected menu, choose Styles... or click the Styles button in the Graph
Control dialog box. Figure 4-9 shows the Graph Style dialog box.

Figure 4-9

Graph Style Dialog Box

2. In the Hardware Status Monitor, click the left mouse button on the graph whose
style you want to change. The graph background turns yellow.
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3. Put the mouse cursor on the line whose style you want to change and click the right
mouse button.
Note: To facilitate selecting a line, zoom the display by holding down the Ctrl key,
pressing the middle mouse button, and moving the mouse. To reset the display,
type r.

4. In the Graph Style dialog box, select the point or line style you want and click the
Apply button to save the setting.
5. When you are satisfied with the settings, click the Close button to exit the Graph
Style dialog box.

Using Graph Control Panels for Specific Graphs
A graph control panel is associated with each graph. To display the control panel for a
graph, follow these steps:
1.

In the Hardware Status Monitor, select the graph for which you want to display a
control panel. The graph background turns yellow.

2. From the Selected menu, choose Graph Controls.... Figure 4-10 shows the graph
control panel for blower speed(s).

Determine whether the selected graph displays live data
Set data density for the selected graph
Set high and low threshold values for an alarm

Display Global Controls dialog box

Figure 4-10
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Graph Control Panel for Blower Speed

Using Alarms

Use features of this panel to
•

set an alarm threshold, as described in “Using Alarms,” later in this chapter

•

set actions to be performed if the threshold is exceeded, as described in “Using
Alarms,” later in this chapter

•

clear an alarm

•

change the point and line style of the graphs, as described in “Changing Point or
Line Styles for Graphs,” earlier in this chapter

•

print the graphs, as described in “Saving Graph Data to a File,” later in this chapter

•

save the graphs as graphs or PostScript® files, as described in “Printing a Graph,”
later in this chapter

Using Alarms
Note: Alarms are not available for Origin or Onyx2 systems. This section and its

subsections do not apply to Origin or Onyx2 systems.
You can set a threshold value for a hardware operating parameter, such as blower speed.
When the value is exceeded, the graph that maps it changes color to alert you that the
threshold has been exceeded and its contents are saved to a file. You can also set
IRISconsole to perform any of the following actions when the threshold is exceeded:
•

cause a beep or tone to be sounded

•

enter a message in an alarms log file in the directory /var/IRISconsole/logs; the default
filename is alarms.log

•

start a notify script

For example, you can set the operating temperature threshold for a CHALLENGE XL in
a site to 37, so that when the system internal temperature exceeds 37 degrees C, the alarm
is triggered.
This section explains
•

setting a threshold for an alarm

•

clearing an alarm

•

viewing an alarm graph file

•

using a notify script
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Setting a Threshold for an Alarm
To set a threshold, follow these steps:
1.

Select the graph for which you want to set an alarm threshold. The graph
background turns yellow.

2. From the Selected menu, choose Graph Controls.... The Graph Control Panel
appears; Figure 4-11 shows the panel for the Temperature graph.

Figure 4-11

Graph Control Panel for Temperature

3. If desired, change the data density (number of points) of the data being sampled.
4. Select the high and low alarm threshold values you want from the choices in the
High and Low fields.
5. If desired, select one or more alarm actions in the Global Controls window.
When the threshold value is reached or exceeded, the graph display turns hot pink when
unselected (bright red when selected).

Clearing an Alarm
To clear an alarm, select the graph whose alarm you want to clear and click the Clear
Alarm button in the Graph Control panel, or choose Clear Alarm from the Selected menu.
To clear all alarms, choose Clear All Alarms from the Options menu.
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Viewing an Alarm Graph File
When a threshold is exceeded, the graph for which the alarm is set is automatically saved
to a file in the directory /var/IRISconsole/logs/alarms. The filename has the format
graphname.<timestamp>.xrt; for example, voltage.951231.1144.0.xrt.
You can view alarm graph files by choosing Display Saved Graph... from the IRISconsole
Hardware Status Monitor File menu; see “Displaying a Graph File,” later in this chapter.

Using a Notify Script
An option in the Global Controls window enables IRISconsole to run a script—
/var/IRISconsole/adm/scripts/icnotify.tclX—when an alarm threshold is exceeded. This
script, which was written in tclX (extended tcl), is self-documenting.
To edit this script, choose Edit Operator Notify Script from the main window Options
window. You must be root to edit this script.
For example, to cause an alarm threshold to send an e-mail message to a specified user,
enter e-mail address(es) in the curly braces in the line
set OPERATORS { }

You can edit icnotify.tclX to include other scripts.

Using Graph Files
Note: Graph files are not available for Origin or Onyx2 systems. This section and its

subsections do not apply to Origin or Onyx2 systems.
You can save, display, and print graph data for CHALLENGE and Onyx systems in files
in either PostScript or image form. The subsections below describe how to perform these
operations.
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Saving Graph Data to a File
You can save a graph to a PostScript file or image file to send to service personnel, or to
compare with other graph data saved to files.
To save a graph to a PostScript file, click the Save As PS... button in the Graph Control
panel. Enter a filename and click the Save button to save the file and exit the dialog box.
To save a graph to an image file, follow these steps:
1.

Freeze the data by clicking the Live Data Feed check box off in the Graph Control
panel (see Figure 4-10 or Figure 4-11). The scroll bars under the graphs are
activated.

2. Click the Save As Graph button in the Graph Control panel. A file selection dialog
box appears, as shown in Figure 4-12.

Figure 4-12

Saving a Graph File

If desired, click the Filter button to display a dialog box in which you can exclude
filename patterns to restrict the filenames displayed.
3. Enter a filename for the graph file in the Selection field.
4. Click the Save button to save the file and exit the dialog box.
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Displaying a Graph File
You can display the saved graph in IRISconsole by choosing Display Saved Graph... from
the IRISconsole Hardware Status Monitor File menu. A dialog box similar to that shown
in Figure 4-12 appears, in which you select the file to display. Files saved as graphs
appear when they are selected.
To display files saved as PostScript files, use your PostScript viewer.

Printing a Graph
You can print a PostScript graph file just as you would print any other PostScript file.
You can also print a graph as it is displayed in the Hardware Status Monitor. Follow these
steps:
1.

In the Hardware Status Monitor, select the graph you want.

2. If desired, change the dimensions of the graph by moving a sash (small square at the
extreme right between the graphs).
3. If desired, select an area of the display by holding down the Ctrl key and pressing
the left mouse button; zoom the selection by moving the middle mouse button.
(Press r to reset the display.)
4. When the screen displays the graph as you want it to be printed, click the Print
button. In the Print dialog box, choose the print options you want.

Renaming or Deleting a Site
You can rename or delete a site using options from the IRISconsole main window Edit
menu.
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Modifying or Deleting a System
If your hardware configuration changes, choose Modify System Config... from the site
window Edit menu to change the parameters for a system in a site.
To delete a system from a site, select it in the site window and choose Delete Selected
System from the Edit menu.
Note: The Save as... option in the site window Edit menu was removed for the

IRISconsole 1.3 release.
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A. Error Messages and Warning Messages

This appendix lists error messages that can appear during operation of IRISconsole. It
interprets each error message and suggests solutions. The messages are listed in
alphabetical order.
<name> is a directory

You selected a directory to save into, when a file was expected.
A site edit session is in progress.
Finish that before opening.

It is not possible to open a site while its configuration information is
being edited. Finish the editing first.
Cannot create directory <name>

Cannot create directory; permissions on /var/IRISconsole should be
writable by the user.
Cannot edit multiple configurations.

You have selected more than one site or system. Select one site or system
at a time to edit.
Caution: Baud rate of a Challenge machine is typically 9600.
Make sure that it is configured to handle this rate.

A legal value other than 9600 was entered in the Baud Rate: field of the
Change Site Config dialog box. Although the baud rate can range from
300 to 115,200, any rate other than the default rate of 9600 needs
configuration changes in the managed server to accept that rate. Note
that this messages is a warning and not an error message.
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Couldn’t find an ST-1600 attached to SCSI bus.

IRISconsole couldn’t detect any multiplexers that should have been
attached to a SCSI port on the back of the OCTANE, O2, or Indy
workstation. Follow these steps:
1.

Check the SCSI target ID on the back of the multiplexer; make sure
that it does not conflict with any other external devices that are
attached. Do not use the settings 0 or 1.

2.

Check the connections of the SCSI cable between the multiplexer
and the OCTANE, O2, or Indy SCSI port. Use the High Density
SCSI-2.cable supplied with the multiplexer or another cable
meeting specifications outlined in the Technical Specifications
chapter of the IRISconsole Multiplexer Installation Guide.

3.

After checking and, if necessary, reseating connectors, ask
IRISconsole to rescan by selecting “Show SCSI Bus Attachments” in
the Options menu of the main IRISconsole window. This action
displays the SCSI IDs of all multiplexers that IRISconsole finds.

Error in getting Hardware Inventory.
Either the target system could not be reached, or
it’s refusing service to the Login ’<login>’

You tried to run hinv on a system in a site. Either the target system could
not be reached, or it is refusing service to your login. Follow these steps:
1.

Check the network connection with the target system (ping or
another command as appropriate).

2.

Check the login you have entered for that system: select the system
and choose “Modify System Config” in the Edit menu of the site
window.

3.

Make sure that the login you entered has permission to perform a
remote operation by typing
rsh login@system hinv

If necessary, correct the login (or get its permissions changed) and
retry the command above.
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Error in ST-1600 software installation
Couldn’t find /sbin/cdscanbus

The multiplexer software subsystem has not been installed. Install it
from the distribution CD.
Failed to create config file

You have attempted to create a new site. Check the permissions on
/var/IRISconsole to see if it is writable for your login.
Failed to fetch /var/adm/SYSLOG: <reason>

The system has probably refused service to your login. Follow these
steps:
1.

Check the login you have entered for that system: select the system
and choose “Modify System Config” in the Edit menu of the site
window.

2.

Make sure that the login you entered has permission to perform the
operation by typing
rsh login@system tail /var/adm/SYSLOG

If necessary, correct the login (or get its permissions changed) and
retry the command above.
Failed to write to file

Your attempt to save the configuration file failed. Check permissions on
/var/IRISconsole/.IC/site/systemname to see if it is writable for your login.
Invalid baud rate:
Should be between 300 and 115200.

An inappropriate baud rate was entered. Baud rates can range between
300 and 115200.
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Invalid field value <value>

The value you entered in this field of the Change Site Config dialog box
is invalid; try again.
Invalid System Console port number
Invalid Remote System Control port number

Multiplexer port numbers may range only from decimal 1 to 32.
Must select a site.
Must select a system.

An attempt was made to perform an operation on a site or system
without actually selecting it. Single-click on the desired site or system
first and try the action again.
No Availability Monitor information to report.
Either <system> doesn’t have an ‘availmon’ running, or
it’s refusing service to the Login <login>

Either the currently selected doesn’t have an availmon running, or it is
refusing service to your login. Check the login you have entered for that
system: select the system and choose “Modify System Config” in the
Edit menu of the site window. If necessary, correct the login (or get its
permissions changed) and retry the operation.
The System Availability Monitoring Facility (availmon) is included in the
eoe2.sw subsystem and must be installed on the Origin, CHALLENGE,
or Onyx server. After it is installed, activate it by typing
/etc/chkconfig avail on
No icons may be dropped into this panel.

This version of IRISconsole does not support drag and drop behaviors
on icons. The icon(s) dropped will automatically be repositioned at their
original locations.

52

No Remote System Control information to report.
Either <system> doesn’t have a ‘sysctlrd’ running, or
it’s refusing service to the Login <login>

Either the currently selected system doesn’t have a sysctlrd running, or
it is refusing service to your login.
If the connected system is a CHALLENGE S, you cannot perform the
action you tried; this type of server has no system controller, which is
required for this action.
For other connected systems, follow these steps:
1.

Check the login you have entered for that system: select the system
and choose “Modify System Config” in the Edit menu of the site
window.

2.

Make sure that the login you entered has permission to perform the
operation by typing
rsh login@system /usr/etc/sysctlrd -p

If necessary, correct the login (or get its permissions changed) and
retry the command above.
Nothing selected.

You have specified an action for which a site or system must be selected.
Select the item and try the action again.
Null input values aren’t allowed.
Spaces not allowed in fields.

Enter a valid value in the field.
Null site name.
Null system name.

An attempt was made to create a site or system with a “null” name.
Names must have at least one character and may not contain spaces.
Please close following site(s) before deleting

You attempted to delete a set of sites when a subset of it was still open.
Close the site(s) and try the action again.
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Port number must be between 1 and 16.

Multiplexer port numbers may range only from decimal 1 to 16.
Rename not allowed when site is open.

An attempt was made to rename a site that is already open. Close the site
first.
SCSI ID must be between 2 and 7.

Inspect the back of the multiplexer for the SCSI target ID used. To verify
that the multiplexer is installed properly, select “Show SCSI Bus
Attachments” in the Options menu of the main IRISconsole window and
check the SCSI ID displayed in the dialog box.
Site is already open.

An attempt was made to open a site that is already open. The site
window appears at the top of the stack of windows.
Site name already exists.
Select it, then “Edit” its configuration.

An attempt was made to create a site that exists already. Create a unique
site with a new name. To change the configuration of an existing site,
select it first.
Spaces not allowed in fields.

Enter a valid value in the field.
System name already exists.
Select it, then “Edit” its configuration.

An attempt was made to create a system that exists already. Create a
unique system with a new name. To change the configuration of an
existing system, select it first.
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/usr/sbin/sysmon not installed.

sysmon.sw, included in the base IRIX release, is a GUI-based tool for
analyzing system logs. Install this system from the IRIX 6.2 (Indy) or
IRIX 6.3 (O2) CD for this feature to function.
You must have eoe.sw.uucp installed.

IRISconsole uses uucp-style locking on device nodes. Install this
subsystem from the IRIX 6.2 (Indy) or IRIX 6.3 (O2) CD.
System selected is not partitioned.

The system was defined to be a partitioned system but upon querying
the system no partitions were found.
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A
alarm, 43-45
clearing, 44
graph file, 45
log file, 43
threshold
display log, 40
setting, 44
Availability Monitor (Availmon) report, 37
problem, 52

Connect SYSCTRL, 36
Console port, configuring, 22
invalid number, 52
conventions, x

D
displaying graph file, 47

E
B
baud rate
configuring, 22, 49
invalid, 51
buttons in site window, 35-37

C
cable
port number, 13
configuring, 22
required, 3
CHALLENGE/Onyx system, 1
ports, 1

error messages, 49-55
/etc/services, editing for ictelnet, 14

G
Generate NMI, 35
and security, 5
Get Console, 35, 36
and security, 5
Global Controls dialog box, 40
graph
control panel, 42-45
displaying file, 47
printing file, 47
saving data to file, 46
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H

L

hardware inventory (hinv output), 38
hardware status information, 38-43
Hardware Status Monitor, 39-40
changing display, 39-42
View menu, 40
hinv
output, 38
problem, 50
HW Reset, 36
and security, 5
HW Status, 36, 38

Log Console Activity to File, 36
log file
alarms, 43
for system activity, configuring, 22
login
configuring, 22
and IRISconsole security login, 22
security, 9, 10

I
icnotify.tclX, 45
.icrc.sitename, 18
ictelnet, 30-32
ictelnet command
and /etc/inetd.conf, 14
and /etc/services, 14
description, 4
IRISconsole
access to remote systems, 1
connecting to remote, 30-32
hardware requirements, 3
monitoring attached systems, 38-43
operation, 15
security, see security
security login and system login, 22
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M
muliplexer, 1
multiplexer
port number, 13
problem, 50
SCSI ID
checking, 12
configuring system, 21
software installation problem, 51

N
non-maskable interrupt, generating, 35
notify script, 45

P
password
changing, 28-29
security, 9, 10
Power Cycle, 36
and security, 5
printing graph file, 47

Index

R
remote access, 30-32
login and password, 32
setting up, 14
Remote System Control port, 1
and multiplexer port number, 13
configuring, 22
invalid number, 52
problem getting information, 53

S
saving graph as file, 46
security, 5, 11
adding administrator, 9
adding user, 10
changing password, 28-29
deleting administrator or user, 29
determining if off or on, 11
login, 9, 10
and remote access, 32
password, 9, 10
and remote access, 32
setting on or off, 11
viewing list, 28
Show Console Logs, 36
and security, 5
site
adding, 18
adding systems to, 20-23, 24-??
administering, 27-48
configuring, 15-23
entering changes, 48
defined, 4

Spy Console, 36
and security, 5
ST-1600, ix
Start Service Tool, 37
Steal Console, 36
and security, 5
system
adding to site, 20-23, 24-??
administration, 35-37
see alsoIRISconsole, monitoring attached systems
System Console port, 1
and multiplexer port number, 13
system log (syslog), 38
problems, 51

U
/usr/sbin/sysmon problem, 55

V
/var/IRISconsole/adm/scripts/icnotify.tclX, 45
/var/IRISconsole and config file, 51
/var/IRISconsole/logs/, 43
View menu, 40
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